
 

 
 
 

RefWorks 
 

 
Setting up an account 
 Go to http://library.usask.ca/hsl/ and click “RefWorks.” (On the left-hand side bar) 
 Log in to your Library Account using your NSID and password. NOTE: this step is crucial if your are 

off-campus 
 Under “New to RefWorks?” choose “Set up an individual account.”  Choose a user name and password. 

 
 
Off-campus access to RefWorks 
 If you are off-campus when you log into RefWorks, you will be prompted to enter your NSID and 

password.  Be sure to enter RefWorks from the library web site – otherwise, you will not be recognized 
as a U of S Library patron, and thus will not have access to the program.   In addition to being asked to 
log in, you may be prompted to enter the group code.  To find the group code, go to 
https://library.usask.ca/resource/R, and look under the RefWorks heading; at the end of this entry you’ll 
see the group code (or a message asking you to log in to get the password required for access).  

 When you first use Write-N-Cite (see below) from off-campus, you will need to set up the Proxy 
Configuration Utility.   

 
 
Saving & Importing records from the Cochrane Library 
 Conduct your search in the standard fashion. 
 Mark  the records you wish to save. 

 Click at the bottom of the screen. 
 Choose Abstract and Citation from the “Export Type” drop-down menu and the appropriate type of 

computer (PC or Mac) from the “File Type” drop-down menu. 

 Click  . 
 Click Save when the File Download dialogue box comes up. 
 Choose the disk drive and folder location to save the records to.  Give your file a name and click Save. 

 NOTE to Firefox users:  Firefox will automatically name your file and download it to the “Downloads”  
            file within the “My Documents” file on your hard drive. 
 Log into RefWorks.   Under References, click Import.  From Import Filter/Data Source, choose 

University of Saskatchewan, and from Database, choose Wiley Interscience [Cochrane Library].   
From Import References into choose the folder into which you wish to import the records. 

 From Import Data from the following Text File, browse to find the file that you saved, and click Open. 
 Click Import to begin importing records. 

 
 
Importing records from an Ebscohost database (CINAHL, SportDiscus, etc.)  
• Conduct your search in the usual way.  
• Click on   for each record you wish to import 

• At the right side of the screen, click on    under  
• Select the items you wish to export.  

• Click on    at the right side of the screen.  
• Choose Direct Export to RefWorks.  
• Click Save  
• If you have not opened RefWorks yet, a new window with the RefWorks login screen will 

appear. Once you log into your RefWorks account you will see a message indicating your 
records have been imported. 

• You may need to allow pop-ups from the database in your RefWorks account before 
the download can be completed. 



 
 
 
 
Importing records from an OVID database (Embase, ERIC, Medline, PsycInfo, etc.) 
• Conduct your search in the usual way 
• Mark the records you wish to import 
• Click on Export in the white bar above your search results 
• In the small box that appears on your screen: 

o Select RefWorks from the Export to drop down menu  
o Select which fields you would like to display in your bibliographic citation 
o Click on Export Citation(s) 

• If you have not opened RefWorks yet, a new window with the RefWorks login screen will 
appear. Once you log into your RefWorks account you will see a message indicating your 
records have been imported. 

 
Sometimes firewalls or other technological complications associated with remote access will 
block a direct export.  Should this occur, try to ‘Export to’ a .txt, RIS, or other format, which will 
require that you download the file to the hard drive of the computer you are using and import it 
into RefWorks. Follow the steps above, choosing .txt, RIS, or some other format, and save the file 
to your computer.  
 
If your file is saved as a .txt: 
• From RefWorks, select Import from the References drop down menu  
• Under Import Filter/Data Source, choose The University of Saskatchewan 
• Under Database, choose the database your references are from 
• Under Import References into Folder: you can either can choose the RefWorks folder into 

which you wish to import the references or leave the default as is 
• Under Import Data from the following Text File, browse to find the file that you saved, and 

double click on it 
• Click Import to begin importing the records. 
 
If importing from other formats, e.g. RIS, the Import Filter/Data Source and the Database 
information must match. 
 
 
Saving & Importing records from Google Scholar  
 Reset the preferences so that Google Scholar displays the option Import to RefWorks. 
  

 Select Scholar Preferences to the right of the Search button.    
 
 Under Bibliography Manager (the last option on the ‘Preferences’ page), choose Show links to 

import citations to and then choose RefWorks from the drop-down menu.   
 Click Save Preferences at the bottom of the page. 
 When you search, you’ll see the Import into RefWorks link after each record. Click this link to import a 

single record.      
 If you haven’t opened RefWorks yet, a new window with the log-in screen will appear.  Once you have 

logged in, you will see the Edit Reference Screen.   
 Click on Folders 
 Click on View 
 Click on Last Imported    

 Select the record  
 From the drop down menu, select the folder in which to put the record: 

 

 
 

 
 
   



 
 
 
 
Saving & Importing records from ISI Web of Knowledge (BIOSIS Previews, CABI, 
Web of Science, Zoological Record, etc.): 
 Log in to your RefWorks account before conducting your search 
 Conduct your Web of Science search in the usual way. 
 Mark   the records you wish to save. 

 At the top of the page, click  

 If the "Export" process does not start automatically, then click   
 
• You may need to allow pop-ups from the database in your RefWorks account before 

the download can be completed. 
 
 
Saving & Importing records from a ProQuest database (ABI/Inform Global, CBCA, 
Canadian Newstand, Dissertations and Theses, etc.) 
 Conduct your search in the standard fashion. 
 Mark  the records you wish to save. 
 At the top of your results list, choose Export. 

 Choose Export directly to RefWorks.  
 If you haven’t opened RefWorks yet, a new window with the log-in screen will appear.  Once you have 

logged in, the references will be imported into RefWorks automatically.   
 From the Last Imported folder, you will be able to move the references into the appropriate folder. 

 
 
Saving & Importing records from PubMed 
 Conduct your search in the standard fashion. 
 Mark  the records you wish to save. 
 Click  from the upper right.  

 Choose “File” as the destination, MEDLINE as the format, and then click . 
 A dialogue box will open. Ensure that “SaveFile” is selected, then click on “O.K.” 
 Choose the disk drive and folder location to save the records to.  Give your file a name and click Save. 

  NOTE to Firefox users:  Firefox will automatically name your file and download it to the  
              “Downloads” file within the “My Documents” file on your hard drive. 
 Log into RefWorks.   Under References, click Import.   
 From Import Filter/Data Source, choose The University of Saskatchewan.   
 Under Database, choose PubMed (NLM PubMed).   
 From Import References into choose the folder into which you wish to import the records. 
 From Import Data from the following Text File, browse to find the file that you saved, and click Open. 
 Click Import to begin importing records. 

 
 
An alternative method for importing individual records from PubMed 
 If you wish to import one PubMed record at a time, you can use RefGrab-it. 
 First, you will need to download RefGrab-it onto the computer you are using.  Under the Tools menu in 

RefWorks, choose RefGrab-it, and follow the directions for downloading it for your computer and 
browser.  

 Conduct your Pubmed search in the standard fashion. 
 Click on the title of the record you are interested in – you should then see only the record of interest on 

your screen.   
 Click RefGrab-it from your browser menu or toolbar.     

 A RefGrab-it window will open, click  to bring the record into your RefWorks 
account. 

 
 
 
 
 
 



 
 
 
 
 
Saving & Importing records from SciFinder Scholar (web version) 

 Conduct your search in the usual way. 
 Mark  the records you wish to save. 
 At the upper right corner of the screen, choose .   
 Give the file a name, choose Tagged Format as the file type and click Export.   
 In the window that opens, click Save File. 

   NOTE to Firefox users:  Firefox will automatically download your file it to the  
                       “Downloads” file within the “My Documents” file on your hard drive. 

 From RefWorks, from the References menu, choose Import.  From Import Filter/Data Source, 
choose The University of Saskatchewan.  Under Database, choose CAPlus [CAS SciFinder].   
From Import References into choose the folder into which you wish to import the records. 

 From Import Data from the following Text File, browse to find the file that you saved, and click 
Open. 

 Click Import to begin importing records. 
 
 
Saving & Importing records from SciFinder Scholar (client/server version) 
 Conduct your search in the usual way. 

 Mark  the records you wish to save. 
 Click Save As from the top of the search screen. 
 Choose Tagged Format as the file type and save on your computer. 
 From RefWorks, from the References menu, choose Import.  From Import Filter/Data Source, 

choose The University of Saskatchewan.  Under Database, choose CAPlus [CAS SciFinder].   From 
Import References into choose the folder into which you wish to import the records. 

 From Import Data from the following Text File, browse to find the file that you saved, and click Open. 
 Click Import to begin importing records. 

 
 
Saving & Importing records from Scopus 
 Log in to your RefWorks account before conducting your search 
 Conduct your search in the usual way. 

 Mark  the records you wish to save. 

 Click on  (located on the grey toolbar directly above your search results). 
 At “Output: Export, Print, E-Mail or Create a Bibliography”: 

Ensure that “Export” is selected 
From the “Export format” menu, select “RefWorks direct export”. 
From, the “Output” menu, select “Complete format” 

 Click on  
 
 
Saving & Importing records from STAT!Ref 
 Conduct your search in the usual way. 
 Click on the title of the result in which you are interested. 

 Click the blue  link at the upper right. 
 Then click . 

 From the drop-down menu, choose Export Directly to RefWorks, and then click . 
 If you haven’t opened RefWorks yet, a new window with the log-in screen will appear.  

       Once you have logged in, the references will be imported into RefWorks automatically.  
 From the Last Imported folder, you will be able to move the references into the appropriate folder. 
 Check to make sure that all the information is complete and accurate. 

 
 

 
 

 
   



 
 
 
 
 
Saving & Importing records from the U of S Library Catalogue 
 Conduct your Catalogue search in the usual way. 
 Click the title of the book you are interested in.   

 Click on  
 If you haven’t opened RefWorks yet, a new window with the log-in screen will appear.  Once you have 

logged in, the references will be imported into RefWorks automatically.   
 From the Last Imported folder, you will be able to move the references into the appropriate folder. 

 
 
Entering references manually   
Sometimes you need to enter references for items that you found without using a database or library 
catalogue.  In this case, follow the steps below. 
 From the top menu bar, click on References. 
 Select Add New Reference.   
 By choosing the style (e.g., APA, Vancouver, etc.) in which you will eventually create your bibliography, 

and indicating Ref Type (i.e., whether this is a reference for a book, journal, web page, etc.), you will 
ensure that all necessary information is entered – required fields are identified with an asterisk (*). 

 Type in the information.  At the bottom of the screen, you will find some tips on entering references in 
the format you have selected.   

 You may want to indicate which folder you would like to add the reference to.   
 When you have finished, click Save.    

 
 
Inserting citations into a Microsoft Word paper 
 Open Word. 
 If Write-N-Cite has been downloaded on the machine you are using, you will see the red icon for it on 

your Word toolbar and/or see it as an option under Tools.  If you don’t see it there, download Write-N-
Cite onto the computer by choosing Write-N-Cite from Tools in RefWorks.  If you use a Windows 
machine, you will be able to download Write-N-Cite III, which is a newer, simpler version of Write-N-
Cite.   

 Once you have downloaded Write-N-Cite, you will need to run the installation program (called either 
wncinstall.exe, wnc3install.exe or macwncinstall.dmg) to install it.  Once you have done this, you should 
see the Write-N-Cite icon in Word. 

 If you are using Write-N-Cite on an off-campus computer, you will need to set up the proxy 
configuration utility.  To set this up on a Windows computer, from the Start Menu select Programs and 
RefWorks. Select the WNC Proxy Configuration Utility.  Into the window that pops up, 
enter     http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?
WNC=true  Click OK. 

 To set up Write-N-Cite on a Mac computer, activate Write-N-Cite. Select Preferences from the Write-
N-Cite menu.  Select the Proxy option and enter 
http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?WNC=t
rue Restart Write-N-Cite for this proxy configuration to take effect. 

 Once Write-N-Cite is installed, click on the Write-N-Cite icon to log in.  From the View menu, you may 
display all references in your account, or only those found in a particular folder.     

 Begin writing your paper.  Position your cursor at the end of the sentence (but before the period) in 
which you wish to cite your source.  

 Enter a single space to separate the citation from the text. 
 From Write-N-Cite, click Cite for the reference of interest.   
 Continue in this fashion until you have completed your paper and all citations have been inserted. 
 *Note that the citations will appear in a temporary format; once you have selected a bibliographic style 

and created your bibliography, in-text citations will be formatted correctly. 
 Save your paper.   
 From Write-N-Cite, click Bibliography.  Choose the style (e.g., APA, Vancouver, etc.) that you wish to 

use.  Click Create Bibliography.   
 If you are using Write-N-Cite II, RefWorks will create a new file, prefixed with the word “Final” that will 

contain the final, formatted bibliography and references. If you wish to reformat your paper in another 
style, or add or delete references, you will go back to the unformatted version that you saved earlier and 
click Bibliography again. 

http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?WNC=true
http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?WNC=true
http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?WNC=true
http://cyber.usask.ca/login?url=http://refworks.scholarsportal.info/Refworks/?WNC=true


 
 
 
 
 
 
 If you are using Write-N-Cite III, RefWorks will format the references in your paper to create a single, 

formatted document with bibliography.  If you want to add additional references to your formatted paper 
or if you wish to format your paper in another style, simply add the additional references (as needed) 
and click Bibliography and choose the style that you want.  If however, you would like to delete 
references from your formatted paper, from Write-N-Cite, click Tools and Display unformatted 
citations, and then Unformat.  This will display all of your references in temporary format.  You can 
then delete unneeded citations, save, and click Bibliography to reformat.   

 
Creating a reference list or bibliography 
 If you want to create an independent bibliography, i.e., a reference list without an accompanying paper, 

click Bibliography from within RefWorks.  Choose the style in which you would like the reference list to 
be created from Output Style.     

 Choose Format a Bibliography from a List of References.  Choose References from and choose 
the folder from which you would like to create the bibliography. 

 Click Create Bibliography.  The bibliography will open in a new window.  From here, the bibliography 
can be printed out.  

 
 
 
If you need more help, go to https://library.usask.ca/uask You may ask a question over the phone, e-mail 
or IM, or to see locations and hours for Library Help Desks.   
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